This version of the software has been retired.
This is a publication of Sage Software, Inc.

Copyright © 2015. Sage Software, Inc. All rights reserved.

Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its affiliated entities. All other trademarks are the property of their respective owners.

Microsoft ©SQL Server®, Windows Vista® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage "AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License: http://na.sage.com/sage-na/eula

Last updated: September 17, 2015
## Contents

### October 2015 Update
- Canadian Payroll Tax Tables ......................................................... 1
- Fixes for the Canadian Edition ......................................................... 1
- Fixes for the U.S. Edition ................................................................. 1

### August 2015 Update
- U.S. Payroll Tax Tables ................................................................. 2
- Fixes for U.S. and Canadian Editions ................................................. 2

### July 2015 Update
- U.S. Payroll Tax Tables ................................................................. 3
- Canadian Payroll Tax Tables .......................................................... 3
- Fixes for the Canadian Edition ......................................................... 3

### May 2015 Update
- U.S. Payroll Tax Tables ................................................................. 4

### Enhancements in Version 19.6
- Sage 100 Contractor Intelligence Reporting ..................................... 5
- General Improvements ................................................................. 6
- Enhancements for the Canadian Edition .......................................... 7
- Enhancements for the U.S. Edition .................................................. 8

### Fixes in Version 19.6
- Fixes for Both Editions ................................................................. 9
- Fixes for the Canadian Edition ...................................................... 10
- Fixes for the U.S. Edition .............................................................. 11

### Known Issues and Comments
- General ......................................................................................... 12
- Windows 8 Professional and Server 2012 Standard Operating Systems ......................................................... 18
- Windows 7 Professional and Server 2008 R2 Standard Operating Systems ......................................................... 19
Windows Vista and Server 2008 Operating Systems ............................................................. 22
October 2015 Update

Canadian Payroll Tax Tables

Provincial and Territorial Payroll Tax Changes

Alberta mandated payroll tax changes, effective October 1, 2015.

For more information about these changes, see the Canada Revenue Agency website.

For detailed information on personal amounts, see the TD1 form for Alberta.

Fixes for the Canadian Edition

The following issues were fixed specifically for the Canadian edition:

- In the 09-05 Takeoffs window, the Subject to PST column is now based on the part, not the job. For example, when a job that is exempt from PST includes a part that is subject to PST, the Subject to PST column indicates Yes for the part.

- When you run a 5-4-1 ROE report for selected employees, you now indicate whether to update the last ROE date for the employees.

Fixes for the U.S. Edition

The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

- Sage 100 Contractor can now calculate and report Kentucky state income tax for Kentucky residents that work and pay income tax in other states.
August 2015 Update

U.S. Payroll Tax Tables

Payroll tax tables have changed for the following jurisdictions:

- Connecticut (revised tax tables are effective January 1, 2015; begin using these tables no later than August 31, 2015)
- Idaho (effective immediately for 2015; retroactive adjustments are not required)
- Ohio (effective August 1, 2015)

Fixes for U.S. and Canadian Editions

We fixed the following issues in both the U.S. and Canadian editions in the August 2015 product update:

- The following reports now provide the correct amounts when the report selection criteria spans more than one fiscal year: 3-1-4-51 Receivable Ledger, 4-1-4-51 Payable Ledger, 6-1-5-21 Current Cost Summary, 6-1-5-31 Buy Out Report~POs Only, 6-1-5-36 Buy Out Report~POs and Subcontracts, 8-1-3-31 Equipment Ledger, and 11-1-4-51 Service Ledger.

- Buy Out reports 6-1-5-31 and 6-1-5-36 now print for jobs that have only a saved Phase 0 and one record.

- The API now accepts times that include midnight, expressed as 00:00:00.

- The API now accepts these special characters: : " { }.
July 2015 Update

U.S. Payroll Tax Tables

Payroll tax tables have changed for the following jurisdictions:

- North Dakota (2015 tax tables revised effective January 1)

Canadian Payroll Tax Tables

The following provinces and territory mandated payroll tax changes, effective July 1, 2015:

- British Columbia
- New Brunswick
- Newfoundland and Labrador
- Yukon

For more information about these changes, see the Canada Revenue Agency website.

For detailed information on personal amounts, see the TD1 form for each province or territory.

Fixes for the Canadian Edition

We fixed the following issue in the July 2015 product update for the Canadian Edition:

- In the Canadian Edition, EFT files your company sends to the Royal Bank of Canada consistently include the required header line (as specified in the 7-2 Company Information window).
May 2015 Update

U.S. Payroll Tax Tables

Payroll tax tables have changed for the following jurisdictions:

- New York City (effective June 1, 2015)
Enhancements in Version 19.6

You will find the following new features and enhancements in Sage 100 Contractor Version 19.6.

Sage 100 Contractor Intelligence Reporting

NOTE: Sage 100 Contractor will integrate with Sage 100 Contractor Intelligence Reporting when it is released in June, 2015.

Sage Intelligence Reporting is a Microsoft Excel-based business intelligence reporting tool designed to help you to make timely, informed decisions for your business, while reducing spreadsheet chaos.

You use Sage Intelligence Reporting to create financial reports and analyze Sage 100 Contractor data using the familiar Microsoft Excel application. It includes the following modules:

- **Report Manager.** Use this module to create and edit reports using Sage 100 Contractor data containers, and to run reports.
- **Report Designer.** Use this module to create new financial reports. You can easily:
  - "Drag and drop" columns and predefined calculations.
  - Create additional calculated fields using the Formula Builder.
  - Change amounts dynamically when forecasting and budgeting.
- **Report Viewer.** Use this module to view existing reports.
- **License Manager.** Use this module to enter or edit Sage Intelligence Reporting module licenses.
- **Security Manager.** Use this module to define security for reports and users.
- **Connector.** Use this module to connect to unlimited ODBC data sources or additional Sage 100 Contractor companies.

IMPORTANT: The first time you run Sage Intelligence Reporting, you must log in as the Windows administrator. A user with Windows administrator privileges must register the ActiveX component, BICore.exe, that Sage 100 Contractor Intelligence Reporting requires. To register this component, open any Sage Intelligence Reporting module. Once the component is registered, other users can use Sage Intelligence Reporting.

Predefined Reports

The following predefined reports come with Sage Intelligence Reporting:

- 2-3 Income Statement: 21 – Income Statement
- 2-3 Income Statement: 31 – Income Statement ~Period and YTD
- 2-3 Income Statement: Dept. Income Statement ~Actual/Budget Comparison
- 3-1-3 Receivables Aging: 26 – AR Invoice Aging ~Land
- 4-1-3 Payable Aging: 26 – AP Invoice Aging ~Land
Enhancements in Version 19.6

- 6-1-1 Job Status Report: 31 – Job Status Report ~Land
- 6-1-12 Committed Cost Report: 31 – Committed Costs ~Land
- 6-1-12 Committed Cost Report: 61 – Committed Costs ~With Cost to Complete
- 6-1-13 Home Builder Reports: 21 – Committed Budget/Cost Variance~by Cost Code
- 6-1-13 Home Builder Reports: 51 – Gross Profit ~by Job
- 6-1-4 Job Summary Report: 21 – Job Cost Summary
- 6-1-4 Job Summary Report: 51 – Job Billing Summary
- 6-1-4 Job Summary Report: 71 – Job Income Statement
- 6-1-8 Bonding Report: 21 – Bonding Report
- 6-6-3 Purchase Order Audit: 31 – Purchase Order Audit ~Land

We plan to include the following reports in the next update:

- 6-7-4 Subcontract Audit: 31 – Subcontract Audit ~Land
- 10-1-5 Gantt Chart: 21 – Gantt Chart
- 11-1-2 Service Invoice List: 91 – Estimated Work Order Profitability
- 11-1-3 Service Aging: Service Invoice Aging ~Land

For information on using Sage Intelligence Reporting, see the Sage Intelligence Reporting help and supporting documentation.

You can also visit the following websites for more assistance:

- [Sage Intelligence Community](#) (includes access to the Sage Intelligence Knowledgebase)
- [Sage Intelligence Academy](#)

**General Improvements**

- In the 9-5 Takeoffs window, you can now declare a work order as taxable when you export only the current grid or the entire takeoff. When you declare a grid taxable, any row that has a part number, a quantity, or a cost type is considered taxable.

- A new link on the Home and Resources tab menu and on the Resources menu (when Activity Centers are not shown) take you to the website for The Users Group for Sage Construction and Real Estate (TUG), a not-for-profit, professional organization committed to supporting the users of Sage 100 Contractor and other Sage construction software.

- Sage Paperless Construction customers should note that Sage 100 Contractor is now compatible with Sage Paperless Construction version 5.1.0.2 or higher.
Enhancements for the Canadian Edition

Quebec Sales Tax (QST) is now handled separately from Provincial Sales Tax (PST). “Separate Treatment for Quebec Sales Tax” below for more information.

In the 5-3-5 Payroll Unions window, we have added a new RPP Account# column. If your company or employees contribute to a union pension fund, enter the registered pension plan (RPP) account number in this column. When you print T4 slips that include contributions to an RPP, the RPP account number associated with the employee’s union appears in Box 50 on their T4 slip.

TIP: For employees who do not belong to a union, create an internal (or "dummy") union record, and use it to record the RPP account number required on their T4 slips.

If your company sends EFT files to the Royal Bank of Canada, note that we have added new RBC Header options to the Vendor EFT Payment Setup and Payroll Direct Deposit Setup tabs in the 7-2 Company Information window. When you use one of these options, Sage 100 Contractor adds a static line to the first line of the associated EFT files, as required by the Royal Bank of Canada.

On the Calculator [F3], the Conversions menu now includes a Standard option, with conversions between Imperial units of measure (for example, from inches to feet, tons to pounds, or gallons to quarts).

In the 9-2 Parts window, you can now select a new Subject to PST option to set material type parts taxable by default when you import or export the parts in the 9-5 Takeoffs window.

In the 9-5 Takeoffs window, the Update menu includes two new options, Set Material Parts as Subject to PST and Clear the Subject to PST column, that let you set or clear the PST tax status for material parts automatically. (Click Update > Grid or Update > Takeoff to see these new options.)

In the 9-7 Maintain Parts Database window, you can use new Subject to PST criteria to change the PST tax status automatically for a selected range of material parts.

Separate Treatment for Quebec Sales Tax

Quebec Sales Tax (QST) is now handled separately from Provincial Sales Tax (PST).

In the Canada Sales Tax Setup window, there is a new QST Paid Account column.

NOTE: The account must be in the asset or liability account type range (but not a WIP account).

If the Canada Sales Tax Setup window includes a QST Paid Account:

- Windows that displayed a GST/HST field now display GST/QST/HST instead.
- In the 3-5 Jobs and 3-6 Receivable Clients windows, a PST/QST Exempt check box appears, rather than PST Exempt.
- In the following windows, if the specified vendor uses a QST tax code, QST rather than PST amounts appear:
  - 4-2 Payable Invoice (grid and invoice footer)
Enhancements in Version 19.6

- 4-6 Recurring Payables (header)
- 4-7-3 Enter Credit Card Receipts
- 4-7-4 Enter Recurring Charges
- 6-6-1 Purchase Orders
- 6-7-1 Subcontracts

  In the following windows, if the specified job uses a QST tax code, QST rather than PST amounts appear:

  - 3-2 Receivable Invoices/Credits
  - 3-7 Progress Billing
  - 3-9 Unitary Billing
  - 3-11 Recurring Receivables

  In the 11-2 Work Orders/Invoices/Credits window, if the province specified on the Location tab is QC, QST rather than PST amounts appear.

  We have added two new QST Filing reports for Quebec: 2-11-31 and 2-11-32.

  Reports 2-11-21 and 2-11-22 no longer include references to Quebec or QST.

**NOTES:**

Job costs are not calculated for transactions that use a QST tax code. Therefore, QST amounts:

- Are not added to committed costs.
- Do not trigger warnings for jobs that are over budget or over subcontract maximums.

### Enhancements for the U.S. Edition

- The first payroll of a new year may include ACA hours attributable to the previous year. Now, when you run the 5-4-3-21 ACA Hours Allocation report for an archive company, you can use the new Combine Company for ACA Hours Allocation window to combine the report results with one other company. The ACA report for the archive company will then include payroll records entered for the previous year in the selected company’s new year.
Fixes in Version 19.6

Version 19.6 includes a number of software fixes, including:

- Fixes for both the U.S. Edition and the Canadian Edition
- Fixes for the Canadian Edition
- Fixes for the U.S. Edition

Fixes for Both Editions

- Drilling down from a 2-3-33 Income Statement ~ Actual/Budget Comparison report shows correct balances for the selected year.
- You can now run a 2-7-21 Chart of Accounts report after you modify the report using version 19.6.

**NOTE:** You will continue to receive an error message if you try to run a 2-7-21 Chart of Accounts report that you modified using an earlier version.

- The 3-1-10-31 Pre-Lien Notice~CA Public Works report now shows the correct subcontractor name and address.
- In the 3-3-1 Cash Receipts window, you can no longer post a cash receipt in error to the Accounts Receivable control account.
- The prompt that appears when you click the Billing Cycle field in the 3-7 Progress Billing window now tells you to enter the billing cycle in the format ##DY, ##MO, ##TH.
- When you save an invoice (without POs) that includes a line with a price but no quantity, Sage 100 Contractor no longer fills in a quantity of 1.0000 automatically. You now receive a warning if a line has no total, but you can save the invoice.
- The 6-6-3-51 Invoices by Purchase Order audit report now lists the correct invoices for each purchase order.
- Titles on the 6-1-7-31 Over/Under Billings~Extended report are no longer cut off.
- In the 9-5 Takeoffs and 11-2 Work Orders/Invoices/Credits windows, selecting the option to hide assembly parts no longer changes the workflow.
- In the 11-2 Work Orders/Invoices/Credits window, the Remove Paid/Void/Completed Records option no longer removes records with an invoice date later than the cut-off date you specify.
- In the 11-2 Invoice Details window, as in the 3-2 Receivable Invoice window, the Discount Available field no longer affects the Net Due amount. (We made a similar change in the API WorkOrderHandler.) Also, when you edit the discount on an existing invoice in the 11-2 Invoice Details window, you are no longer prompted to unlock the transaction fields for editing.
Fixes for the Canadian Edition

The following issues were fixed specifically for the Canadian edition:

- Grand totals on the 2-11-21 GST/HST Filing and the 2-11-22 reports for the same period now match, even if you do not use Province criteria when you run the 2-11-21 GST/HST Filing report.

  **NOTE:** In the 1-1 Cheques/Bank Charges and 1-3 Journal Transactions windows, when you enter a transaction that includes a GST/HST Paid, QST Paid, or RITC account, you must now specify a province before you can save the transaction.

- Tax calculation in the 3-2 Receivable Invoices/Credits, 3-7 Progress Billing, 3-9 Unitary Billing, 3-11 Recurring Receivables, 11-2 Work Orders/Invoices/Credits windows now uses four decimal places to avoid rounding errors. This higher precision is also used in the API (in ARInvoice ADD, WORK Order, ADD, and MOD).

- Deposits and prepayments that you enter in the 3-2 Receivable Invoices/Credits window and the 11-2 Work Orders/Invoices/Credits window no longer appear as credits in the Net Sales/ Purchases column on the 2-11-21 GST/HST Filing and the 2-11-31 GST Filing reports.

- The 2-11-21, 2-11-22, 2-11-31, and 2-11-32 GST/HST Filing Reports now display the correct total for Net Sales/Purchases.

- Accounts Payable 4-1-2 Invoice List reports (4-1-2-21 through 4-1-2-89) now report holdback amounts consistent with the General Ledger, including any holdbacks that remain on paid invoices.

- When you create a company based on an existing company, accrued vacation due is not passed to the new company.

- In the 5-3-1 Payroll Calculations window, when setting up Tax Type - 6 Vacation Accrual payroll calculations, you can now:
  - Select Use in Payrops.
  - Select any calculation method.
  - Add to Gross payroll calculations that are not subject to deductions now work as expected when the Exclude from T4 slips check box is selected in the 5-3-1 Payroll Calculations window. Box 14 on T4 slips no longer includes these calculations.

- The 5-3-7 Payroll Audit now reports total CPP deductions correctly.

- The total insurable earnings reported for weekly employees in Box 15B on the 5-4-1 Record of Employment is now based on the employee’s earnings for the previous 27 weeks.

- In the 5-4-1 Federal Tax Forms and eFiling by Aatrix window, if more than one amount is calculated for Box 40 for an employee, Sage 100 Contractor reports a single combined amount in Box 40 when you process the T4 Official Form.

- In the 6-7-1Subcontracts window, a subcontract can now have blank rows if there is no contract amount.
Fixes for the U.S. Edition

The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

- The Aatrix Alaska Certified Payroll report now uses the address from the Alaska Domicile Information window, which you open from the Options menu. (Frequently, the address on the 5-2-1 General Information tab is a PO Box used as the mailing address for the employee, which is not sufficient for the report.) If the Address 1 field is empty on the employee’s Alaska Domicile Information, the general address is used instead.

- When printing state filing reports for California in the 5-4-2 State Tax Forms and eFiling by Aatrix window, box C on the DE-88 form and boxes F1 and F2 on the DE-9 form now include the correct information even if the W-2 Box and W-2 Code fields are filled in on the state disability (SDI) calculation.

- The 5-4-3-21 ACA Hours Allocation report now excludes voided 5-2-2 payroll records and bonus records that have no hours recorded on the grid.

- The 5-4-3-21 ACA Hours Allocation report no longer shows ACA hours for the previous year on the current year’s ACA report.

- Subcontract values shown on the 6-7-4-21, 6-7-4-31, and 6-7-4-41 Subcontract Audit reports are now reduced by the amount withheld on the payable invoice for vendor’s workers compensation.
Known Issues and Comments

The following sections describe known issues and problems in Sage 100 Contractor Version 19.6.

General

Internet access required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or e-filing tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_requirements.htm.

Sage Advisor Update

Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage 100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

TIP: Use the Customize settings in the Windows system tray to make sure you can view the Sage Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see “About Sage Advisor Update” in the User Guide and in the Sage 100 Contractor help.

Tax Forms and eFiling by Aatrix configuration requirements

Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

- For updating forms and executable files.
- For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an Internet firewall. Firewalls need to have access allowed through specific ports:
The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site http://updates.aatrix.com.

The eFiling component uses secure HTTPS on port 443 to access the site https://efile.aatrix.com.

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.

For updating using http on port 80 to http://updates.aatrix.com:

- aatrixforms.exe
- updater.exe
- updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

- builder.exe
- viewer.exe

**Locating tax updates**

Tax updates are released throughout the year. To get the latest information about tax updates:

2. In the Solve a common problem section, click Sage Contractor Downloads and Updates.

**Printing reports at year-end (U.S. Edition)**

As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the amount paid in the future period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year end.

**TIP:** If you archive your data at year end, you can also print the reports from the Archive, later.

**PCI DSS Compliance**

PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card companies as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security weaknesses and threats.
A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to process credit card payments and being audited and/or fined. (For more information about PCI standards, see https://www.pcisecuritystandards.org/)

Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting you from exposure to non-compliance penalties and credit card fraud.

⚠️ **CAUTION:** To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 Contractor. Such storage creates unnecessary risk for your business and your customers.

### Use Adobe Reader Version 8.1.3 or later for faxing

Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

**IMPORTANT:** To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your Windows operating system. For more information about installing the Windows Fax Service component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

### Printing reports to PDF or exporting to Excel?

When you print reports to PDF, you may find that the size of the PDF file is unexpectedly large and the resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in Compatibility Mode (compatible with Windows 7), and then print the report.

**NOTE:** You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if you use Microsoft Office 2013.

We have not encountered this issue during testing, nor has it been reported for Windows Server 2012 R2.

### About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:
File sharing on computers running the Windows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Help.

TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.

Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.

**Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2 Standard**

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8, Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

**Configuring anti-virus software and third-party firewalls**

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

**To configure the Windows Firewall:**

1. For Windows Vista or Server 2008, click **Start > Control Panel > Security**.
   
   For Windows 7, click **Start > Control Panel > System and Security**
   
   For Windows 8, click **Start > All apps > Control Panel > System and Security**.
2. Open **Windows Firewall**, and then select **Allow a program or feature through Windows Firewall**.
3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selecting **Add Program**, then browsing to the following path: \MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

**NOTE:** By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the **Change Scope** button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.

**Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit**

- C:\MB7
Known Issues and Comments

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

**Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit**

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

**Files to exclude when manually configuring your firewall for Windows Vista 32-bit**

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

**Files to exclude when manually configuring your firewall for Windows Vista 64-bit**

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data
Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data


- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
Known Issues and Comments

- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Configuring Windows Regional and Short Date Format

To specify regional formats for Windows:

1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under Date and time formats, from the Short date format drop-down list, select the format used for your country.
5. Click [OK].
6. Close the Clock, Language, and Region window.

Posting Status for a Company Created since Version 19.2

If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise after you advance the year to the first period of the new fiscal year. The new year may not be available when you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered this issue, contact Customer Support for assistance.

Windows 8 Professional and Server 2012 Standard Operating Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 8 Professional or Server 2012 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.
Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8 Professional or Windows 8 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2012, follow these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click Explore.
2. On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click [Edit].
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.
   (Selecting Full control selects all the check boxes necessary for this solution.)
6. On the Permissions window, click [OK].
7. On the MB7 Properties window, click [OK].

Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

IMPORTANT: On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as administrator.”

Microsoft Windows changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have limited privileges in some areas of the program, such as saving a report schedule. To
save a report schedule, you must launch Sage 100 Contractor with the command to either Run as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you run the program as administrator for that session only. When you select Run this program as an administrator, you set program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related to Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are running.

To set "Run as administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, to launch the program, click Run as administrator.

NOTE: Selecting Run as administrator only runs the current session of running Sage 100 Contractor. The setting does not persist after the session is over.

To set "Run this program as an administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, click Properties.
3. On the Sage 100 Contractor Properties window, click the Compatibility tab.
4. Under Privileges Level, select Run this program as an administrator.
5. Click [Apply], and then click [OK].

NOTE: Selecting Run this program as an administrator always runs the program with these properties when you launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a license server, when it goes into sleep mode, other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.
**Windows Server 2008 R2 and Microsoft .NET 3.5.1**

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn't install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

**To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:**

1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.

**To enable .NET 3.5.1 on Windows Server 2008 R2:**

1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].

**NOTE:** Enabling .NET Framework 3.5.1 may require a reboot.

**Solution for Server 2008 R2 "Permission Error Opening File"**

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 R2 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click Open Windows Explorer.
2. On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click the Edit button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.

Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK].
7. On the MB7 Properties window, click [OK].

Solution for Windows 2008 Server R2 Application Error Message

Under some circumstances, on servers operating Windows 2008 Server R2, you may see the following error message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install Desktop Experience using the Server Manager utility:

1. In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2. In the Server Manager window, click Features (left-hand pane).
3. In the Features pane, click Add Features.
4. Select the Desktop Experience check box.
5. If you are prompted to add additional features, click [Add Required Features].
6. Click [Next].
7. Click [Install].

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click [Explore].
2. On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.
3. On the MB7 Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, then click the [Edit] button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box. Selecting Full control selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].
Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license use

If you are using a Vista or Server 2008 computer as the Sage license server and it goes into Sleep Mode, the workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in place of Vista or Server 2008.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to "Never":

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License Server computer

On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the computer from the list of computers on your network, the command may fail to generate a list of network computer names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-bit operating system

On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may encounter a conflict with the Microsoft print spooler (splwow.exe) and may not function as expected.

To avoid this potential conflict, schedule reports on computers running a 32-bit operating system.